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Before Getting Started

It may be difficult to identify the important points in some illustrations without a
color copy of this booklet.  You can print or read this booklet in color from
MicroImages’ Web site.  The Web site is also your source for the newest Getting
Started booklets on other topics.  You can download an installation guide, sample
data, and the latest version of TNTlite.

http://www.microimages.com

TNTsim3D™ for Windows provides you with the ultimate way to explore your
geospatial data: real-time, interactive, 3D viewing.  Use your joystick, keyboard,
or mouse to move over and around a simulated 3D landscape and view your
geospatial data from any vantage point.  You prepare data for use in TNTsim3D
with the Landscape Builder process in TNTmips®.  Each landscape file contains a
texture raster object precisely matched to a terrain raster;  the texture raster layer
can include any visual combination of geospatial data.

Prerequisite Skills  TNTsim3D is easy to use even if you have no previous
experience with geospatial analysis software.  If you have used a flight simulator
software program and have a joystick, you are already familiar with moving through
a simulated 3D scene.  But even those without a joystick can use the keyboard to
easily control movement, speed, and attitude.

Sample Data  The exercises presented in this booklet use sample data distributed
with the TNT products.  If you do not have access to a TNT products CD, you
can download the data from MicroImages’ web site.  In particular, this booklet
uses sample files BIGPINE.SIM and CRATERLK.SIM in the SIMDATA directory on the
TNT V6.6 products CD. You can also use any of the other landscape files on the
CD (or on MicroImages web site) with TNTsim3D.

More Documentation  This booklet is intended only as an introduction to the
features of TNTsim3D for Windows.  A companion Tutorial Exercises booklet
covering the Landscape Builder in TNTmips is in preparation.

TNTmips and TNTlite®  TNTmips comes in two versions: the professional ver-
sion and the free TNTlite version.  If you did not purchase the professional
version (which requires a software license key), TNTmips operates in TNTlite
mode, which limits object size and enables data sharing only with other copies of
TNTlite.  TNTsim3D can be used only on Windows computers by licensed users
of the professional TNTproducts.

Randall B. Smith, Ph.D.,22 January 2002
©MicroImages, Inc., 2002
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� Copy the files in the
SIMDATA folder on the TNT
V6.6 products CD to
your local drive

Welcome to TNTsim3D
Most geospatial data that you work with is a selec-
tive representation of a complex three-dimensional
landscape, but flat maps and images frequently con-
vey little sense of the vertical dimension.  Contours
and relief shading can be included with the map data
for this purpose, but the ideal way to visualize the
true shape of your geospatial data is to combine the
data with an elevation model and “fly” over and
around a 3D scene, examining features from any van-
tage point in real time.

TNTsim3D for Windows provides this capability for
users of the TNT professional products.  It allows
you to move over 3D terrains using joystick, key-
board, or mouse controls.  You can control all aspects
of the viewer orientation (attitude), height above
the surface, and speed.  Special visual effects are
also available, such as automatic texture smoothing
and atmospheric effects (fog / haze).

You create the data for the simulator using the Land-
scape Builder process in TNTmips, which creates a
terrain raster object and a texture raster object that
are specially optimized for real-time interactive 3D
rendering.  Both of these objects are stored together
in a landscape file, a specialized type of TNT Project
File with the file extension *.sim.

TNTsim3D is similar in many respects to flight simu-
lator software products.  It uses similar 3D rendering
principles and techniques and provides the same
real-time 3D movement.  But the purpose of flight
simulator software is to mimic the experience of flight,
including different weather conditions and the flight
characteristics of different types of aircraft; the back-
ground landscape is secondary.  The purpose of
TNTsim3D, on the other hand, is to allow you to
view your geospatial data as a landscape.  Its em-
phasis is on allowing you to move around and over
the simulated landscape in real time while maintain-
ing the quality of the landscape rendering.

The exercises on pages 4-5
cover hardware and
software requirements,
launching TNTsim3D, and
loading data.  Default
keyboard motion controls
and instructions for
configuring other input
devices are found on pages
6-10.  Pages 11-12 cover
other input options and
adjusting the tradeoff
between terrain quality and
frame rate.  Texture
smoothing, fog, and other
special effects are
discussed on pages 13-15.
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Launching TNTsim3D

STEPS
� launch TNTsim3D
� if a Select Graphics

System window opens,
select either DirectX or
OpenGL and click [OK]

TNTsim3D is installed
automatically when you
install TNTmips.  A shortcut
to the program is created in
the MicroImages \
TNTproducts folder shown
in the Windows Start menu.
You can launch TNTsim3D
from the Start menu, or
copy this shortcut to the
Windows desktop.  You can
also double-click on any
TNTsim3D landscape file to
launch the program and
load the data from that file.

Before running TNTsim3D, make sure that either
OpenGL v1.1 or Microsoft DirectX 8.0 (or a later ver-
sion) is installed in your Windows system.  OpenGL
is a cross-platform program library for 3D rendering
and 3D hardware acceleration.  Support for OpenGL
v1.1 is included with Windows98, NT 4.0, and later
versions of the Windows operation system.  DirectX
is a suite of Microsoft multimedia program libraries
that include Direct3D for 3D rendering and hard-
ware acceleration and DirectInput for configuring
motion controls for input devices (such as keyboard
and joystick).  The TNTsim3D page on the
MicroImages web site provides links to instructions
on how to determine what version of DirectX is in-
stalled and how to download and install updates.

If only DirectX or OpenGL is installed on your com-
puter, TNTsim3D will open directly using that
graphics system.  If both DirectX and OpenGL are
installed, before TNTsim3D opens you will be pre-
sented with a window asking you to select which
graphics system to use.  In principle, DirectX and
OpenGL provide similar capability and performance
in 3D rendering.  Both systems can take advantage
of any 3D rendering capabilities built into your dis-
play board to accelerate performance, which means
higher frame rates and smoother movement.  How-

ever, some display boards and
drivers may not provide equal sup-
port for DirectX and OpenGL, so one
may perform better than the other
on your computer.  You will need to
experiment to determine which sys-
tem works best for you.  For best
performance, make sure that you
have the most recent Windows-cer-
tified driver for your video display
board, and follow the manufacturer’s
instructions to adjust hardware ac-
celeration settings.

For information on and updates for the 3D
graphics libraries used by TNTsim3D, go to:

• www.opengl.org
• www.microsoft.com/directx
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STEPS
� choose Open from the

File menu
� navigate to the directory

into which you copied
the landscape files
(*.SIM) from the
TNTproducts 6.6 CD

� select BIGPINE.SIM

� choose Wireframe from
the View menu

� repeat the previous step
to return to solid view

� select Options from the
View menu and
examine the Display
panel, then click [OK]

Loading a Landscape File
TNTsim3D opens by default with a single window
on your desktop.  The File and View menus provide
access to most of the program controls.  The File
menu is used to open a landscape file and to exit the
program.  This menu also shows the last four land-
scape files you have used, providing easy loading
of recently-used data.

When you open a landscape file, TNTsim3D reads
the terrain raster in the file and constructs a 3D model
of the terrain surface. The surface model is a mesh of
interlocking 3D triangles that provides an efficient
approximation of the terrain surface.  The texture
raster object is then draped over this surface model.
To see the surface model alone,
choose View / Wireframe; this menu
option acts as a toggle between
solid and wireframe view modes.
The state you have set when you
exit the program is used by default
when you next open it.

You can resize the TNTsim3D win-
dow by dragging any edge or corner,
or use the standard Windows maxi-
mize/restore button on the right side
of the window title bar.  Keep in mind,
though, that increasing the window
size puts a larger demand on video memory and may
reduce the speed and smoothness of movement
through the simulation.  In some instances your at-
tempt to enlarge the window may exceed the amount
of available video memory.  TNTsim3D in that case
returns to the previous window size and displays an
error message explaining the problem.  DirectX ap-
pears to be more demanding of video
memory than OpenGL.  If both graphics
systems are available on your computer,
you can switch between them using the
Graphics System menu on the Display
panel of the Options window.

wireframe view

solid view

You can switch between
DirectX and OpenGL on the
fly using the Graphics
System menu on the
Options / Display panel.
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First Flight: Using Keyboard Controls

Default input control
settings. If DirectX is
installed there are no
Num key assignments.

Although you may already have a joystick or other
flight control device installed on your computer, let’s
use the keyboard for your first flight, because a num-
ber of actions have been pre-assigned to specific
keys.  These default input control settings are shown
the first time that you open the TNTsim3D Controls
window.  You can keep this window open on your
desktop as a quick reference to the keyboard con-
trols while you try them out.

The keyboard controls allow you to move in various
directions through the scene, control forward and
backward speed, and change your viewing orienta-
tion (attitude).  The attitude controls use the same
motions that would apply to an aircraft: pitch, roll,
and turn.  If you are not familiar with these terms,

pitch affects the vertical angle in the direction of
flight, roll affects the angle of the wings relative
to the horizontal, and turn affects the heading
(the horizontal direction of flight).

The way in which you use a key on the key-
board depends upon which control is assigned
to it.  The general motion controls (Altitude Up/
Down, Forward/Backward, Slide Right/Left/Up/
Down, Pitch Up/Down, Roll Right/Left, Turn Left/
Right) move you at a specified speed (discussed
later) as long as the key is held down.  To move
forward without having to continue holding a
key down, use the Throttle Up Key, which in-
creases your speed by a fixed amount each time
it is pressed.  The Throttle Down key slows your
forward speed and, if you slow down to a stop,
moves you backward at increasing speed.  The

Throttle 0 key stops the motion begun by the other
Throttle keys, while Roll 0 levels the wings of the
virtual plane.  The Look Right/Left/Up/Down keys
direct your view in a particular direction as long as
they are held down.  The Altitude Lock key acts as
an on/off toggle for maintaining the current altitude.

STEPS
� choose Show Controls

from the View menu
� using the keyboard

motion controls shown,
experiment with moving
through the 3D scene

The normal view direction is
straight ahead in the
direction of flight.  Use the
Look Right/Left/Up/Down
keys to temporarily look in
other directions.
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STEPS
� use the left mouse

button to drag the
Position Status bar
outside the TNTsim3D
window, forming a
separate window

� select Recenter from
the View menu

� select Restore Initial
Viewpoint from the
View menu

A simulation opens with a default viewer position
above the upper left corner of the scene, pointing
toward the scene center.  As you fly around, infor-
mation on your viewing position is shown by default
in a Position Status bar at the bottom of the
TNTsim3D window.  This bar shows your horizontal
(x y) position (in map coordinates if the simulation
objects are georeferenced), altitude above sea level
and height above the terrain surface (both in meters),
and angles in degrees for pitch, roll, and heading.
You can use the mouse to drag and redock the Posi-
tion Status bar at the other edges of
the window or move it outside the
TNTsim3D window to form a sepa-
rate auxillary window.  An option on
the View menu also allows you to
toggle the Position Status bar on and
off.

In some situations, especially if you
are flying relatively fast, you may get
disoriented and lose track of where
you are and of your attitude.  You
may find yourself pointing up to the
sky and not know where the terrain is, or fly right
through the terrain surface and end up underneath
it.  The position status information can help you
figure out where you are.  In the latter case, for ex-
ample, the Height Above Surface parameter would
show a negative value.  You could then use the Al-
titude Up control to move back above the surface.

If you can’t get yourself reoriented manually, or
don’t want to bother, there are two short cuts avail-
able on the View menu.    You can use the Recenter
option to maintain your current position but reori-
ent the view toward the center of the scene.  If that is
not sufficient, you can choose Restore Initial View-
point, which jumps the viewer position and
orientation back to those of the starting point.

Keeping Track of Where You Are

The Status Bar at the
bottom of the TNTsim3D
window shows the current
program status and also
acts as a tool tip when you
open a menu, providing a
description for the menu
option you have currently
highlighted.

Drag the Position Status
bar to reposition it.
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Find Surface Coordinates with the Mouse
STEPS
� move the mouse cursor

within the TNTsim3D
window

� note how the Mouse
Position and Mouse
Elevation values in the
Position Status list
update continuously
update

As we have seen, knowing your viewing position in
the simulation is important. But TNTsim3D enables
you to view georeferenced spatial data, so you may
be more interested in finding the map coordinates
and surface elevation of particular locations on the
landscape surface.  With TNTsim3D you can use
the mouse to determine point coordinates for any
visible portion of the scene.

When you place the mouse over some point on the
scene in the TNTsim3D window, the program projects
a sight line from the viewer position through the
screen position of the cursor and on to the corre-
sponding position on the landscape surface.  The

horizontal (x y) map coordi-
nates of this position are
reported as the Mouse Posi-
tion item in the Position Status
list.  (If the landscape objects
are not georeferenced, the line
and column numbers of the
corresponding terrain raster
cell are shown.)  The Mouse
Elevation entry shows the cor-
responding surface elevation,
which is interpolated from the
closest terrain raster cells along
the sight line.  These coordi-

nate readouts are updated continuously as you
move the mouse cursor over the scene.  Deter-
mining the positions of any number of scene
locations is quick and easy.
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STEPS
� from the View menu

select Options
� click on the Input tab
� if you have a Configure

DirectInput button at the
bottom of the panel,
press it

� click on the Keyboard
tab and edit the
keyboard controls if you
wish

� click [OK] on the
DirectInput window and
the Options window

TNTsim3D uses the DirectInput software compo-
nent of DirectX to allow you to configure the flight
controls for your keyboard or other input device.
You can reconfigure the controls while operating
the simulator in either DirectX or OpenGL, but
DirectX must be installed on your system in order
for you to do so.  (OpenGL does not provide an
input configuration utility.)  If you do not have
DirectX installed, there will be no DirectInput push
button on the Options window Input panel, and you
will be limited to using the default keyboard con-
trols.  If so, this would be a good time to download
and install the latest version of DirectX from
Microsoft (see page 4).

The DirectInput window has a tabbed panel
for a joystick or other game controller (if
one is installed in your system), the key-
board, and the mouse.  The right side of
the keyboard panel lists the keys and the
currently assigned action for each.  To
change the assignment for a key, click on
its entry in the list or press the key on the
keyboard.  Either action highlights the con-
trol entry and shows a scrolling list of
available actions
in the lower left
portion of the
panel.  To activate
the action list,
press Enter (or
double-click on
the control entry)
and select a new
action from the
scrolled list.

Configuring Input Controls

DirectInput control window
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Configuring a Joystick
STEPS
If you have a joystick or
other game controller, make
sure that it is:
� plugged into your

computer
� set up and calibrated in

Microsoft Windows

Then proceed to
� press the Configure

DirectInput button on the
Options window Input
panel

� select the tabbed panel
for your controller

� configure the stick
(axis) controls and the
button controls

� close the DirectInput
and Options windows

� practice moving with the
joystick, supplemented
by keyboard controls as
needed

A joystick, yoke, or similar game controller gives
you more realisitic, intuitive control over your move-
ments in TNTsim3D.  The lowest-cost joysticks have
only two rotation axes, so you must change roll and
pitch (bank the plane) to make turns.  Higher-priced
(but still inexpensive) joysticks allow the stick to
twist, providing three axes of rotation and indepen-
dent control of turn, roll, and pitch.  They also have
a separate throttle control that can be operated with
your other hand, as well as a number of buttons that
can control other motions.

You can also use the mouse as a motion control, but
only in a very limited way.  The mouse is better used
to interact with the data in the TNTsim3D window,
as described later.

TNTsim3D allows simultaneous use of different in-
put devices.  So even if you have a joystick, you
may still want to use the keyboard to control some
actions.  For example, if your joystick does not have
a throttle control, you can use the throttle up, throttle
down, and throttle 0 controls on the keyboard to
control your speed.

Sample action
assignments that I
have set for the 3-
axis joystick I use
at MicroImages.  I
move the stick
forward or back to
change pitch, side
to side to roll, and
twist it to turn.
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Setting Other Input Options
STEPS
� from the View menu

select Options
� click on the Input tab
� change the value in the

Speed Forward /
Backward field to 500

� turn on the Minimum
Height check box and
change the height value
to 400

� click [OK] on the Options
window

� use any controls to
move closer to the
terrain surface until you
reach the minimum
height you have set

The Input panel on the Options window also pro-
vides other settings that affect your movement
through the simulation.  In the upper left part of the
panel are three linear speed settings: Up / Down,
Left / Right, and Forward / Backward.  All are ini-
tially set to the same velocity (in meters per second),
which is based on the areal dimensions of the land-
scape.  The default speed is computed to traverse
the maximum extent (height or width) of your land-
scape in 120 seconds.  Each of these linear speed
values sets the speed used by the associated mo-
tion control.  When you use the throttle controls to
increment speed, the Speed Forward / Backward
value sets an upper velocity limit.  You can change
any of these linear speeds to move more quickly.
But keep in mind that at faster speeds the
scene changes rapidly, forcing TNTsim3D
to read more data more quickly, and the
image information held in memory must be
updated more frequently.  Your movements
may become less smooth, and you may see
more transient rendering artifacts.

Flight following the ups and downs
of terrain at minimum height of 400 m.

The settings in the upper right part of the
panel control the angular speeds (in de-
grees per second) for pitch, roll, and turn.
The default values are independent of the
landscape characteristics, and any
changes you make are retained for
use in later sessions.  You can also
set both minimum and maximum
height values, which are also re-
tained until reset.  Setting a minimum
height prevents you from flying
through and then under the terrain
surface.  If you set the same value
for minimum and maximum height,
you can maintain a constant height
above the surface while flying in any
direction.
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Terrain Quality and Frame Rate
STEPS
� turn on the Wireframe

view mode (View /
Wireframe)

� select Options from the
View menu

� click on the Terrain tab
� increase the Quality

setting to 90 and click
[OK], and note the
increased detail in the
wireframe

� reset the Quality
percentage to 75

To improve both quality and frame rate, try the following:
� shut down other programs to free computer resources for TNTsim3D
� make the TNTsim3D window smaller
� make sure your graphics card’s 3D acceleration options are turned on
� get a graphics card with faster 3D acceleration and more video memory
� get more random access memory (RAM) for your computer

A new terrain model is built
for each frame using only
the visible part of the
terrain.  The level of terrain
detail varies spatially in
each frame.  More detail is shown
(by smaller terrain triangles) in the
foreground and in areas of
greater local relief.  As you move
through the simulation, the amount
of detail for a particular area may
change, but height values are
automatically adjusted to produce
gradual rather than abrupt visual
changes in local detail.

You can also set a Vertical
Exaggeration scaling factor
for the terrain model to vary
the vertical scale.

As you use TNTsim3D, you will likely want to move
through each landscape smoothly and realistically
and at the same time see the maximum possible scene
detail.  But achieving these twin goals may exceed
the resources available on your computer, so you
may need to choose which of them is more impor-
tant to you for a particular simulation session.

You can make that choice in TNTsim3D by using the
settings on the Options window’s Terrain panel,
where a pair of radio buttons allow you to give pref-
erence to either quality or frame rate.  Quality refers
to the amount of detail in the surface model created
from the terrain raster in the landscape file.  Quality
is expressed numerically as a percentage; setting a
higher percentage produces a surface model that
shows more of the detail in the terrain raster.  Frame
rate is the number of times the scene is redrawn each
second.  A higher frame rate produces smoother,
more natural movement through the landscape.

If you choose the Quality preference, TNTsim3D uses
available resources to maintain your target terrain
quality and reduces the frame rate if necessary.  If
you choose the Frame Rate preference, the program
instead attempts to maintain your target frame rate

and lets the terrain qual-
ity vary as needed.  The
effects of these selec-
tions depend greatly on
the hardware capabili-
ties of your computer;
they are more significant
for newer, faster com-
puters and graphics
cards.
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Texture Smoothing
STEPS
� turn off the Wireframe

view mode (View /
Wireframe)

� select Options from the
View menu and click on
the Effects tab

� left-click on the
Background Color color
sample button

� use the resulting Color
window to select a light
blue background color
and click [OK]

� if the Smooth Texture
checkbox on the Effects
panel is active (not
dimmed), turn it on

� click OK on the Options
window

unsmoothed smoothed

TNTsim3D window with new
background color and DirectX texture
smoothing enabled.  Magnified views
of boxed area are shown above with
and without texture smoothing.

The Effects panel of the Options window lets you
control a number of visual effects for your simula-
tions, including background color, fog, and texture
smoothing.  The Background Color control allows
you to pick the background color from a standard
palette or define one or more custom colors for use
as backgrounds.

The Smooth Texture option is available only when
you are using DirectX as the graphics rendering
system for TNTsim3D.  Smoothing has two major
advantages: it reduces the blocky appearance of fore-
ground texture cells viewed at close range, and it
reduces “sparkle” in the more distant portions of
the moving image.  If you have a modern graphics
board with 3D acceleration, the smoothing is per-
formed by the graphics
hardware itself, so there is
minimal impact on frame
rate.  (If your board does
not support hardware
smoothing, the DirectX
software performs the
smoothing, though more
slowly).
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Using Fog
STEPS
� select Options from the

View menu and click on
the Effects tab

� turn on the Fog check
box, accept the default
settings, and click [OK]

� note the change in
scene visibility

� reopen the Options
window Effects panel,
change the Start value
to 2000 and the End
value to 20000, then
click [OK]

� note the change in
scene visibility

� reopen the Options
window Effects panel
and change the Fog
method to Exponential
Two

� set the Density value to
7.0 and click [OK]

When you view a natural landscape, detail and color
become less distinct in more distant parts of the
scene because of the effects of water vapor and par-
ticulates in the atmosphere.  Haze is almost always
present to some extent, and fog is an extreme ex-
ample.

To add realism to a landscape in TNTsim3D, you can
simulate the reduction of visibility with distance by
using the Fog controls.  The fog effect is achieved
by blending texture colors with varying amounts of
a designated fog color.  The background color is the
default fog color, which lets the hazy or foggy ter-
rain blend naturally into the sky.  For special effects
you can turn off the Use Background Color check
box and use the Fog Color control to select any color
for the color blending.

Three methods are available to control the variation
in fog density with increasing distance from the

viewer.  In the Linear method, the Start value
defines the distance at which the fog effect
begins, the End value defines the distance
at which fog no longer increases, and the
variation is linear between these limits.
Since the start and end distances are in

meters, the same pair of
values will produce differ-
ing effects for landscapes
of different areal extents.

In the Exponential method, fog increases ex-
ponentially with distance.  In the Exponential
Two method, fog increases exponentially
with the square of the distance.  In both
methods the Density parameter is a multi-
plier applied to the distance exponent.

Increasing the Density pa-
rameter makes the fog
thicken more rapidly with
increasing distance.

Fog: Linear

Fog: Exponential Two
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STEPS
� reopen the Options

window Effects panel,
turn off the Fog check
box, then click [OK]

� choose Open from the
File menu

� navigate to the directory
into which you copied
the landscape files
(*.SIM) from the
TNTproducts 6.6 CD

� select CRATERLK.SIM

� choose Options from
the View menu and click
on the Extras tab

� turn on the Show
Compass checkbox

� notice how the
compass rotates as you
move through the
landscape

Using the Compass Graphic
The Extras panel on the Options window lets you
turn on a rotating compass graphic that is shown in
the lower right corner of the simulation window.  The
compass graphic can help you keep track of your
direction of view in three dimensions.

The graphic consists of a central sphere, arrows that
point in the four cardinal directions (north, east,
south, and west), and arrows for the four intermedi-
ate directions (northwest and so on).  The north
arrow, other cardinal arrows, and intermediate arrows
are shown in separate colors.  (Color controls let
you change the arrow colors if you wish.)  If the
landscape objects are georeferenced, the north ar-
row points in the north direction; otherwise it points
parallel to the column direction in the rasters.

The compass points are drawn to lie in the horizon-
tal plane, so the compass image provides a visual
cue to your attitude relative to the
horizontal.  This attitude information
is enhanced by shading effects on
the points and central sphere, which
are illuminated from above.

Enter a new Size value to change
the size of the compass graphic.



page 16

Advanced Software for Geospatial Analysis

M icro Im a g es, In c .
11th Floor - Sharp Tower
206 South 13th Street
Lincoln, Nebraska  68508-2010  USA

Voice: (402) 477-9554 email: info@microimages.com
FAX: (402) 477-9559 internet: www.microimages.com

MicroImages, Inc. publishes a complete line of professional software for advanced geospatial
data visualization, analysis, and publishing.  Contact us or visit our web site for detailed prod-
uct information.

TNTmips TNTmips is a professional system for fully integrated GIS, image analysis, CAD,
TIN, desktop cartography, and geospatial database management.

TNTedit TNTedit provides interactive tools to create, georeference, and edit vector, image,
CAD, TIN, and relational database project materials in a wide variety of formats.

TNTview TNTview has the same powerful display features as TNTmips and is perfect for
those who do not need the technical processing and preparation features of TNTmips.

TNTatlas TNTatlas lets you publish and distribute your spatial project materials on CD-
ROM at low cost.  TNTatlas CDs can be used on any popular computing platform.

TNTserver TNTserver lets you publish TNTatlases on the Internet or on your intranet.
Navigate through geodata atlases with your web browser and the TNTclient Java applet.

TNTlite TNTlite is a free version of TNTmips for students and professionals with small
projects.  You can download TNTlite from MicroImages’ web site, or you can order
TNTlite on CD-ROM.
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